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Application Notes for Configuring SIP Trunking using 

Verizon Business IP Trunking Service with Avaya IP Office 

Release 11.1 – Issue 1.0 
 

Abstract 
 

  

These Application Notes describe a reference configuration using Session Initiation Protocol 

(SIP) trunking between the Verizon Business IP Trunking service offer and an Avaya IP 

Office solution. In the reference configuration, the Avaya IP Office solution consists of an 

Avaya IP Office Server Edition Primary Server Release 11.1, an Avaya IP500 V2 Expansion 

System Release 11.1, Voicemail Pro and Avaya SIP, H.323, digital, and analog endpoints. 

 

The Verizon Business IP Trunking service offer referenced within these Application Notes is 

designed for business customers. The service enables local and long distance PSTN calling via 

standards-based SIP trunks directly, without the need for additional TDM enterprise gateways 

or TDM cards and the associated maintenance costs. 

 

Readers should pay attention to Section 2, in particular the scope of testing as outlined in 

Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases 

are adequately covered by this scope and results. 

 

Information in these Application Notes has been obtained through DevConnect compliance 

testing and additional technical discussions. Testing was conducted in the Avaya Solution & 

Interoperability Test Lab, utilizing a Verizon Business Private IP (PIP) circuit connection to 

the production Verizon Business IP Trunking service. 
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1. Introduction 
These Application Notes describe a reference configuration using Session Initiation Protocol 

(SIP) trunking between the Verizon Business IP Trunking service offer and an Avaya IP Office 

solution. In the reference configuration, the Avaya IP Office solution consists of an Avaya IP 

Office Server Edition Primary Server, an IP500 V2 Expansion System, Voicemail Pro and 

Avaya SIP, H.323, digital, and analog endpoints.  

 

Avaya IP Office is a versatile communications solution that combines the reliability and ease of 

a traditional telephony system with the applications and advantages of an IP telephony solution. 

This converged communications solution can help businesses reduce costs, increase productivity, 

and improve customer service. 

 

These Application Notes complement previously published Application Notes by illustrating the 

configuration screens and Avaya testing of IP Office Release 11.1.  

 

Verizon Business IP Trunking service offer can be delivered to the customer premises via either 

a Private IP (PIP) or Internet Dedicated Access (IDA) IP network termination. Although the 

configuration documented in these Application Notes used Verizon’s IP Trunk service 

terminated via a PIP network connection, the solution validated in this document also applies to 

IP Trunk services delivered via IDA service terminations. 

 

For more information on the Verizon Business IP Trunking service, including access 

alternatives, visit https://enterprise.verizon.com/products/business-communications/voip-and-

voice-services/voip-ip-trunking/ 

2. General Test Approach and Test Results  
The general test approach was to connect a simulated enterprise site to the Verizon Business IP 

Trunking service, as depicted in Figure 1. Avaya IP Office was configured to use the 

commercially available SIP Trunking solution provided by the Verizon Business IP Trunking 

service. This allowed Avaya IP Office users to make calls to the PSTN and receive calls from the 

PSTN via the Verizon Business IP Trunking service. 

 

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The 

jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent 

to the interoperability of the tested products and their functionalities. DevConnect Compliance 

Testing is not intended to substitute full product performance or feature testing performed by 

DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or 

completeness of a DevConnect member’s solution. 

 

Avaya recommends our customers implement Avaya solutions using appropriate security and 

encryption capabilities enabled by our products. The testing referenced in these DevConnect 

Application Notes included the enablement of supported encryption capabilities in the Avaya 

products. Readers should consult the appropriate Avaya product documentation for further 

information regarding security and encryption capabilities supported by those Avaya products. 

https://enterprise.verizon.com/products/business-communications/voip-and-voice-services/voip-ip-trunking/
https://enterprise.verizon.com/products/business-communications/voip-and-voice-services/voip-ip-trunking/
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Support for these security and encryption capabilities in any non-Avaya solution component is 

the responsibility of each individual vendor. Readers should consult the appropriate vendor-

supplied product documentation for more information regarding those products. 

2.1. Interoperability Compliance Testing 

To verify SIP trunking interoperability, the following features and functionality were covered 

during the interoperability compliance test: 

• Incoming calls from the PSTN were routed to the DID numbers assigned by Verizon 

Business to the Avaya IP Office location. These incoming PSTN calls arrived via the SIP 

Line and were answered by Avaya SIP telephones, Avaya H.323 telephones, Avaya 

digital telephones, analog telephones, analog fax machines, Avaya IX Workplace for 

Windows softphones and Avaya Voicemail Pro. The display of caller ID on display-

equipped Avaya IP Office telephones was verified. 

• Incoming calls answered by members of Hunt Groups were verified. 

• Outgoing calls from the Avaya IP Office location to the PSTN were routed via the SIP 

Line to Verizon Business. These outgoing PSTN calls were originated from Avaya SIP 

telephones, Avaya H.323 telephones, Avaya digital telephones, analog endpoints, Avaya 

IX Workplace for Windows and Avaya Voicemail Pro. The display of caller ID on 

display-equipped PSTN telephones was verified. 

• Inbound / Outbound fax using G.711 and T.38 were verified. 

• Proper disconnect when the caller abandoned a call before answer for both inbound and 

outbound calls. 

• Proper disconnect when the IP Office party or the PSTN party terminated an active call. 

• Proper busy tone heard when an IP Office user called a busy PSTN user, or a PSTN user 

called a busy IP Office user (i.e., if no redirection was configured for user busy 

conditions). 

• Various outbound PSTN call types were tested including long distance, international, 

toll-free, operator assisted, and directory assistance calls. 

• Requests for privacy (i.e., caller anonymity) for IP Office outbound calls to the PSTN 

were verified. That is, when privacy is requested by IP Office, outbound PSTN calls were 

successfully completed while withholding the caller ID from the displays of display-

equipped PSTN telephones.  

• Privacy requests for inbound calls from the PSTN to IP Office users were verified. That 

is, when privacy is requested by a PSTN caller, the inbound PSTN call was successfully 

completed to an IP Office user while presenting an “anonymous” display to the IP Office 

user. 

• SIP OPTIONS monitoring of the health of the SIP trunk was verified. Both Verizon 

Business and IP Office were able to monitor SIP trunk health using SIP OPTIONS. 

• IP Office outbound calls were placed with simple short codes as well as using ARS. 

Using ARS, the ability of IP Office to route-advance to an alternate route was exercised 

when the primary SIP line was not responding. The Line Group associated with the 

Verizon Business SIP Trunk was the primary line group chosen for a call, or an alternate 

line group was selected upon failure of a primary line. 

• Incoming and outgoing calls using the G.729A and G.711MU codecs. 



 
MAA; Reviewed: 

SPOC 6/30/2020 

Solution & Interoperability Test Lab Application Notes 

©2020 Avaya Inc. All Rights Reserved. 

4 of 44 

VzIPT-IPO11_1 

 

• DTMF transmission (RFC 2833) with successful voice mail navigation using G.729A and 

G.711MU for incoming and outgoing calls. Successful navigation of a simple auto-

attendant application configured on Avaya Voicemail Pro. 

• Inbound and outbound long holding time call stability. 

• Telephony features such as call waiting, hold, transfer, and conference. 

• Attended call transfer using the SIP REFER method. 

• Unattended or “blind” call transfer using the SIP REFER method. 

• Inbound calls from Verizon IP Trunk service that were call forwarded back to PSTN 

destinations, presenting true calling party information to the PSTN phone, via Verizon IP 

Trunk service.  

• Mobile twinning to a mobile phone, presenting true calling party information to the 

mobile phone. Mobility Features such as Outbound and Inbound Mobile Call Control.  

were also verified successfully. 

• DiffServ markings in accordance with network requirements for IP Office SIP signaling 

and RTP media. 

2.2. Test Results 

Interoperability testing of the reference configuration was completed with successful results. The 

following observations were noted: 

• SIP endpoint transfers: When Refer based call transfers are performed, Verizon does 

not send NOTIFY SIP messages to Avaya IP Office to signal transfer completion. Some 

Avaya SIP endpoints (e.g., Avaya 1140E, and Avaya IX Workplace for Windows) 

require receipt of a NOTIFY when Refer based call transfers are performed. Without the 

NOTIFY messages, these IP Office users may briefly see “Transfer failed” on the display 

after the final user operation, even if the transfer has actually succeeded.  The IP Office 

SIP Line option, Emulate NOTIFY for REFER can be set, to send the necessary 

NOTIFY messages to these endpoints (see Section 5.4.6), avoiding this issue.  

• Emergency 911/E911 Services Limitations and Restrictions – Although Verizon 

provides 911/E911 calling capabilities, 911 capabilities were not tested; therefore, it is 

the customer’s responsibility to ensure proper operation with its equipment/software 

vendor. 

 

Note – These Application Notes describe the provisioning used for the sample configuration 

shown in Figure 1. Other configurations may require modifications to the provisioning described 

in this document. 

2.3. Support 

For technical support on the Avaya products described in these Application Notes visit 

http://support.avaya.com. 

 

For technical support on Verizon Business IP Trunking service offer, follow the online support 

links at https://enterprise.verizon.com. 

 

http://support.avaya.com/
https://enterprise.verizon.com/
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3. Reference Configuration 
Figure 1 illustrates an example Avaya IP Office solution connected to the Verizon Business IP 

Trunking service. The Avaya equipment is located on a private IP subnet. An enterprise edge 

router provides access to the Verizon Business IP Trunking service network via a Verizon 

Business T1 circuit. This circuit is provisioned for the Verizon Business Private IP (PIP) service.  

 

The reference configuration consisted of the following components: 

• Avaya IP Office provides the voice communications services for a particular enterprise site. 

In the reference configuration, Avaya IP Office runs on the Avaya IP Office Server Edition 

platform. Note that this solution is extensible to deployments using the standalone IP500 V2 

platform as well.  

• In the sample configuration, the Primary server runs the Avaya IP Office Server Edition 

Linux software. Avaya Voicemail Pro, running as a service on the Primary Server, provided 

the voice messaging capabilities in the reference configuration.  

• The Expansion System (V2) is used for the support of digital, analog and additional IP 

stations. It consists of an Avaya IP Office 500 V2 with analog and digital extension 

expansion modules, as well as a VCM64 (Voice Compression Module). 

• Avaya endpoints are represented with Avaya 9608 H.323 Deskphones, Avaya J169 SIP 

Deskphones, Avaya 1140E SIP Deskphones, Avaya 9508 Digital Deskphones, as well as 

Avaya IX Workplace for Windows (SIP) softphones. Fax endpoints are represented by PCs 

running Ventafax emulation software connected by modem to the IP Office analog ports. 

• In the reference configuration, Avaya IP Office interface “LAN 1” (labeled LAN) is 

connected to the private CPE, and interface “LAN 2” (labeled WAN) is connected to the 

public network and Verizon Business IP Trunking service.  

• In the reference configuration, Avaya IP Office receives traffic from the Verizon Business IP 

Trunking service on port 5060 and sends traffic to port 5071, using UDP for network 

transport, as required by the Verizon Business IP Trunking service.  

• Verizon Business IP Trunking service provided Direct Inward Dial (DID) numbers. These 

DID numbers were mapped to IP Office destinations via Incoming Call Routes in the IP 

Office configuration. 

• Verizon Business used the Fully Qualified Domain Name (FQDN) 

pcelban0001.avayalincroft.globalipcom.com.  

• The Avaya CPE environment was assigned FQDN adevc.avaya.globalipcom.com by Verizon 

Business. 
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Figure 1: Avaya Interoperability Test Lab Configuration 
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4. Equipment and Software Validated 
Table 2 shows the equipment and software used in the reference configuration. 

 

Avaya IP Telephony Solution Components 

Equipment Software 

Avaya IP Office Server Edition 

- Avaya IP Office Voicemail Pro 

Release 11.1.0.0.0 Build 237 

Release 11.1.0.0.0 Build 234 

Avaya IP Office 500 V2 Expansion System Release 11.1.0.0.0 Build 237 

Avaya IP Office Manager Release 11.1.0.0.0 Build 237 

Avaya 96x1 Series IP Deskphone (H.323) Release 6.8304 

Avaya 1140E IP Deskphone (SIP) Release 04.04.23.00 

Avaya J169 IP Deskphone (SIP) Release 4.0.4.0.10 

Avaya IX Workplace Client for Windows Release 3.8.4.10.2 

Avaya 9508 Digital Deskphone Release 0.60 

 

Table 1: Equipment and Software Tested 

 

Compliance Testing is applicable when the tested solution is deployed with a standalone IP 

Office 500 V2, and also when deployed with all configurations of IP Office Server Edition. Note 

that IP Office Server Edition requires an Expansion IP Office 500 V2 to support analog or digital 

endpoints or trunks. 



 
MAA; Reviewed: 

SPOC 6/30/2020 

Solution & Interoperability Test Lab Application Notes 

©2020 Avaya Inc. All Rights Reserved. 

8 of 44 

VzIPT-IPO11_1 

 

5. Avaya IP Office Primary Server Configuration 
IP Office is configured via the IP Office Manager program. For more information on IP Office 

Manager, consult reference [4]. From the IP Office Manager PC, select Start → Programs → 

IP Office → Manager to launch the Manager application. Navigate to File → Open 

Configuration (not shown), select the proper Avaya IP Office system from the pop-up window, 

and log in using the appropriate credentials. 

 

 
 

On Server Edition systems, the Solution View screen will appear, similar to the one shown 

below. All the Avaya IP Office configurable components are shown in the left pane, known as 

the Navigation Pane. Clicking the “plus” sign next to the Primary server system name, e.g., 

IPOSE-Primary, on the navigation pane will expand the menu on this server. In the sample 

configuration, IP users registered to the Primary server. Digital and Analog users are configured 

on the Expansion System. The SIP trunk to Verizon Business is configured on the Primary 

server. 
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In the screens presented in the following sections, the View menu was configured to show the 

Navigation pane on the left side, the Group pane in the center and the Details pane on the right 

side. These panes will be referenced throughout the rest of this document.  

 

Standard feature configurations that are not directly related to the interfacing with the service 

provider are assumed to be already in place, and they are not part of these Application Notes. 

5.1. Licensing  

In the reference configuration, IPOSE-Primary was used as the system name of the Primary 

Server and IP500 Expansion was used as the system name of the Expansion System. All 

navigation described in the following sections (e.g., License) appears as submenus underneath 

the system name in the Navigation Pane. 

 

The configuration and features described in these Application Notes require the IP Office system 

to be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity, 

contact an authorized Avaya sales representative.  
 

Navigate to License in the Navigation Pane. In the Details Pane verify that the License Status 

for SIP Trunk Channels is Valid and that the number of Instances is sufficient to support the 

number of channels provisioned for the SIP trunk. 
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5.2. System Settings 

This section illustrates the configuration of system settings. Select System in the Navigation 

pane to configure these settings. The subsection order corresponds to a left to right navigation of 

the tabs in the Details pane for System settings. For all the following configuration sections, the 

OK button (not shown) must be selected in order for any changes to be saved. 

5.2.1. LAN1 Settings 

In the reference configuration, LAN1 is used to connect the Primary server to the enterprise 

network. To view or configure the IP Address of LAN1, select the LAN1 tab followed by the 

LAN Settings tab. As shown in Figure 1, the IP Address of the Primary server is 10.64.19.170. 

Other parameters on this screen may be set according to customer requirements. 

 

 
 

Select the VoIP tab as shown in the following screen. The H323 Gatekeeper Enable parameter 

is checked to allow the use of Avaya IP Telephones using the H.323 protocol, such as the Avaya 

96x1 deskphones used in the reference configuration. The H.323 Signaling over TLS is set to 

Preferred to allow TLS signaling for H.323 endpoint that support it. The SIP Registrar Enable 

parameter is checked to allow Avaya J169, Avaya 1140E, and Avaya IX Workplace usage. The 

SIP Domain Name and SIP Registrar FQDN may be set according to customer requirements. 

Set the parameters on the Layer 4 Protocol section based on customer needs.  
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5.2.2. LAN2 Settings 

In the sample configuration, LAN2 is used to connect the IP Office to the Verizon Business 

network. To view or configure the IP Address of LAN2, select the LAN2 tab followed by the 

LAN Settings tab. As shown in Figure 1, the IP address of the IP Office, known to Verizon, is 

“1.1.1.2”. DHCP Mode is set to “Disabled” since DHCP is unnecessary towards Verizon.  

 

 
 

Select the VoIP tab as shown in the following screen. The H323 Gatekeeper Enable and SIP 

Registrar Enable boxes are unchecked since IP telephones will not be registering on this link. 

The SIP Trunks Enable box must be checked to enable the configuration of SIP trunks to 

Verizon Business. 

 

If desired, the RTP Port Number Range can be customized to a specific range of receive ports 

for the RTP media paths from Verizon Business to IP Office. The defaults are used here. 
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Scrolling down the page, on the Keepalives section, set the Scope to RTP-RTCP. Set the 

Periodic timeout to 30 and the Initial keepalives parameter to Enabled. These settings will 

cause the Primary server to send RTP and RTCP keepalive packets starting at the time of initial 

connection and every 30 seconds thereafter if no other RTP or RTCP traffic is present. This 

facilitates the flow of media in cases where each end of the connection is waiting to see media 

from the other, as well as helping to keep ports open for the duration of the call. 

 

In the DiffServ Settings section, the Primary server can be configured to mark the Differentiated 

Services Code Point (DSCP) in the IP Header with specific values to support Quality of Services 

(QoS) policies for both signaling and media. The DSCP field is the value used for media, while 

the SIG DSCP is the value used for signaling. These settings should be set according to the 

customer’s QoS policies in place. In the sample configuration shown below, IP Office will mark 

the RTP media with a value associated with “Expedited Forwarding” using DSCP decimal 46 

(DSCP parameter). IP Office will mark SIP signaling with a value associated with “Assured 

Forwarding” using DSCP decimal 28 (SIG DSCP parameter). 
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Select the Network Topology tab as shown in the following screen. The Firewall/NAT Type 

was set to Open Internet in the sample configuration. Note that the Firewall/NAT Type 

parameter may need to be set differently, depending on the type of firewall or Network Address 

Translation device used at the customer premise. Binding Refresh Time (sec) was set to 60 

seconds. This is used to determine the frequency at which Avaya IP Office will send SIP 

OPTIONS messages, to periodically check the status of the SIP trunk connection to Verizon 

Business. The Public IP Address and Public Port sections are not used for the Verizon 

Business SIP trunk service connection. 

 

 

5.2.3. Voicemail Settings 

To view or change voicemail settings, select the Voicemail tab as shown in the following screen.  

The settings presented here simply illustrate the reference configuration and are not intended to 

be prescriptive. The Voicemail Type in the reference configuration is Voicemail Lite/Pro. The 

Voicemail IP Address in the reference configuration is 10.64.19.170, the IP address of the 

Primary server running the Voicemail Pro software.  
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5.2.4. System Telephony Settings 

To view or change telephony settings, select the Telephony tab and Telephony sub-tab as 

shown in the following screen. The settings presented here simply illustrate the reference 

configuration and are not intended to be prescriptive. In the reference configuration, the Inhibit 

Off-Switch Forward/Transfer parameter is unchecked so that call forwarding and call transfer 

to PSTN destinations via the Verizon Business IP Trunking service can be tested. That is, a call 

can arrive to IP Office via the Verizon Business IP Trunking, and be forwarded or transferred 

back to the PSTN with the outbound leg of the call using the Verizon IP Trunk service. The 

Companding Law parameters are set to U-Law as is typical in North American locales. Other 

parameters on this screen may be set according to customer requirements. 
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5.2.5. System VoIP Settings  

To view or change system codec settings, select the VoIP → VoIP tab. The RFC2833 Default 

Payload field allows for the manual configuration of the payload type used on SIP calls that are 

initiated by the IP Office. During the compliance test, this was set to 101, the value preferred by 

Verizon Business. For codec selection, on the left, observe the list of Available Codecs. In the 

example screen below, which is not intended to be prescriptive, the parameter next to each codec 

is checked, making all the codecs available in other screens where codec configuration may be 

performed (such as the SIP Line in Section 5.4.55). The Default Codec Selection area enables 

the codec preference order to be configured on a system-wide basis, using the up, down, left, and 

right arrows. By default, all IP (SIP and H.323) lines and extensions will assume the system 

default codec selection, unless configured otherwise for the specific line or extension.  
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During the compliance test, SRTP was used internal to the enterprise wherever possible. To view 

or configure the media encryption settings, select the VoIP → VoIP Security tab on the Details 

pane. The Media Security drop-down menu is set to Preferred to have IP Office attempt use 

encrypted RTP for devices that support it and fall back to RTP for devices that do not support 

encryption. Under Media Security Options, RTP is selected for the Encryptions and 

Authentication fields. Under Crypto Suites, SRTP_AES_CM_128_SHA1_80 is selected. 

 

 

5.3. IP Route 

In the reference configuration, the Primary server LAN1 port is physically connected to the local 

area network switch at the IP Office customer site. The default gateway for this network is 

10.64.19.1.  

 

The IP Office LAN2 port is physically connected to the Verizon PIP network and has a default 

gateway of 1.1.1.1. To add an IP Route in the Primary server, right-click IP Route from the 

Navigation pane, and select New (not shown). To view or edit an existing route, select IP Route 

from the Navigation pane, and select the appropriate route from the Group pane. The following 

screen shows the Details pane with the relevant route using LAN2 as Destination. 
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5.4. SIP Line 

This section shows the configuration screens for the SIP Line in IP Office Release 11.1. The 

recommended method for configuring a SIP Line is to use the template associated with these 

Application Notes. The template is an .xml file that can be used by IP Office Manager to create a 

SIP Line. Follow the steps in Section 5.4.1 to create the SIP Line from the template. 

 

Some items relevant to a specific customer environment are not included in the template or may 

need to be updated after the SIP Line is created. Examples include the following: 

• IP addresses 

• SIP Credentials (if applicable) 

• SIP URI entries 

• Setting of the Use Network Topology Info field on the Transport tab. 

 

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary 

after the SIP Line is created via the template. The resulting SIP Line data can be verified against 

the manual configuration shown in Sections 5.4.2 – 5.4.6. 

 

In addition, the following SIP Line settings are not supported on Basic Edition: 

 

• SIP Line – Originator number for forwarded and twinning calls. 

• Transport – Second Explicit DNS Server. 

• SIP Credentials – Registration Requirement. 

• SIP Advanced Engineering. 

 

Alternatively, a SIP Line can be created manually. To do so, right-click Line in the Navigation 

Pane and select New → SIP Line. Then, follow the steps outlined in Sections 5.4.2 – 5.4.6.  
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5.4.1. Creating a SIP Line from an XMLTemplate 

Note – DevConnect generated SIP Line templates are always exported in an XML format. 

These XML templates do not include sensitive customer specific information and are 

therefore suitable for distribution. The XML format templates can be used to create SIP 

trunks on both IP Office Standard Edition (500v2) and IP Office Server Edition systems. 

Alternatively, binary templates may be generated. However, binary templates include all the 

configuration parameters of the Trunk, including sensitive customer specific information. 

Therefore, binary templates should only be used for cloning trunks within a specific 

customer’s environment. 

 

Copy a previously created template file to the computer where IP Office Manager is installed. To 

create the SIP Trunk from the template, right-click on Line in the Navigation Pane, then navigate 

to New →New from Template. Select Open from file.  

 

 
 

Navigate to the directory where the template was copied on the local computer (e.g., \temp) and 

select it. Click Open (not shown). 

 

 
 

The new SIP Line is created, and it will appear on the Navigation pane (e.g., SIP Line 21). The 

resulting SIP Line data can be verified against the manual configuration shown in Sections 5.4.2 

to 5.4.6. 
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5.4.2. SIP Line – SIP Line Tab 

The SIP Line tab in the Details pane is shown below for Line Number 21, used for the Verizon 

Business IP Trunking service.  

 

The ITSP Domain Name is left blank. With this setting, IP Office will use the ITSP Proxy 

Address (see Section 5.4.3) as the host part in the SIP URIs of the destination headers (Request 

URI and To headers) for outbound calls. Local Domain Name is set to the IP address of the 

Avaya IP Office LAN2 interface (e.g., 1.1.1.2). IP Office will use this IP address as the host part 

in origination headers (From, Contact, P-Asserted Identity and Diversion headers). 

 

By default, the In Service and Check OOS boxes are checked. In the reference configuration, IP 

Office will use the SIP OPTIONS method to periodically check the SIP Line. The time between 

SIP OPTIONS sent by IP Office will use the Binding Refresh Time for LAN2, as shown in 

Section 5.2.12. 

 

Under Session Timers, the Refresh Method is set to “Reinvite” and the Timer (seconds) is set 

to 1800. With this configuration, IP Office will send re-INVITEs every 15 minutes (half of the 

set value) to keep the active session alive. 

 

Under Redirect and Transfer, the default setting for the automatic determination of Incoming 

Supervised REFER and Outgoing Supervised REFER is Auto. Alternatively, the default can 

be overridden with Never to explicitly disable use of supervised REFER, or Always to explicitly 

enable use of supervised REFER, as shown below. The Send 302 Moved Temporarily setting is 

unchecked, as Verizon does not support receiving a 302 Moved Temporarily message. 

Optionally, the Outgoing Blind REFER parameter can be checked to enable use of REFER for 

blind transfers. 
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5.4.3. SIP Line - Transport Tab 

Select the Transport tab. The ITSP Proxy Address is set to the IP address provided by Verizon 

(172.30.209.21), as shown in Figure 1. In the Network Configuration area, UDP is selected as 

the Layer 4 Protocol. The Send Port is set to the port number provided by Verizon Business. 

As shown in Figure 1, this port is 5071 in the sample configuration The Listen Port can retain 

the default value 5060. The Use Network Topology Info parameter is set to None. 

 

 

5.4.4. SIP Line – Call Details Tab 

Select the Call Details tab. To add a new SIP URI, click the Add… button. A New URI area 

will be opened. To edit an existing entry, click an entry in the list at the top, and click the Edit… 

button.  
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In the example screen below, a previously configured entry is edited. The Incoming Group 

parameter, set here to 21, will be referenced when configuring Incoming Call Routes to map 

inbound SIP trunk calls to IP Office destinations in Section 5.88. The Outgoing Group 

parameter, also set to 21, will be used for routing outbound calls to Verizon via ARS (Section 

5.99). The Max Sessions parameter was set to “10”. This value sets the maximum number of 

simultaneous calls that can use the URI before IP Office returns busy to any further calls. 

 

Auto is selected for the Local URI, Contact and Diversion Header parameters. With this 

configuration, information in the Incoming Call Route (Section 5.88) is used determine what call 

is accepted on the SIP Line. The Incoming Call Route for individual users will also be used to 

populate the SIP From and Contact headers for outbound calls. Set the Field meaning section to 

the values shown in the screenshot below. 

 

 
 

In the reference configuration, the single SIP URI shown above was sufficient to allow incoming 

calls for Verizon DID numbers destined for specific IP Office users, hunt groups or short codes.  
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The following screen shows an example configuration for Verizon’s Unscreened ANI feature. 

This optional configuration allows customers to send an “unscreened” ANI to Verizon’s network 

which is then displayed to the called party as Caller ID. An “unscreened” ANI can be any 

telephone number that the customer passes through Verizon’s network for Caller ID display 

purposes only. If this feature is enabled on the Verizon IP Trunk services, Verizon will designate 

one of the assigned telephone numbers as a “Screened Telephone Number” for each unique 

location. Verizon will use this Screened Telephone Number to determine call origination for 

billing, call routing, and E911. 

 

The Screened Telephone Number (STN) provided by Verizon for this test is 732-945-0821. 

Typically, customers would have one or more STN; one for every location. A central Primary 

server could be used to pass multiple STNs to Verizon based on the Outgoing Group selected. 

The STN would then be entered in the Diversion Header field as shown below. 
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5.4.5. SIP Line - VoIP Tab 

Select the VoIP tab. The Codec Selection drop-down parameter System Default (default) will 

match the codecs set in the system wide Default Selection list (System → VoIP). In the 

reference configuration, Custom is selected and the codecs G729(a) 8K CS-ACELP and G.711 

ULAW 64K preferred by Verizon are specified. This will cause IP Office to include these 

codecs in the Session Description Protocol (SDP) offer, in that order. The Fax Transport 

Support drop-down is set to T38 Fallback. This enables T.38 to be used for fax if supported, 

and will fall back to G.711 if not. The DTMF Support parameter can remain set to the default 

value RFC2833/RFC4733. The Media Security parameter can retain its default value of 

“Disabled” as Verizon does not support media encryption. The Re-invite Supported parameter 

is checked to allow for codec re-negotiation in cases where the target of an incoming call or 

transfer does not support the codec originally negotiated on the trunk.  

 

For PSTN originations, Verizon preferred the G.729a codec in the SDP, while also allowing the 

G.711MU codec. During testing, the IP Office configuration was varied such that G.711MU was 

the preferred or only codec listed, and G.711MU calls were also successfully verified. 
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5.4.6. SIP Line – SIP Advanced Tab 

Select the SIP Advanced tab. In the Identity area, the Use PAI for Privacy parameter is 

checked to include the caller’s DID number in the P-Asserted-Identity (PAI) SIP header for a 

privacy requested call. This PAI SIP header is required by Verizon Business to admit an 

otherwise anonymous caller to the network. The Caller ID from From header parameter is 

checked to have IP Office use the Caller ID information in the From SIP header rather than the 

PAI or Contact SIP header for inbound calls. This will allow the Caller Name presented in the 

From SIP header by Verizon Business to also be included in the Caller ID. 

 

In the Media area, the Indicate HOLD parameter is checked to have IP Office send an INVITE 

with media attribute “sendonly”, indicating the call was placed on hold. This is the preferred 

behavior for Verizon Business to indicate placing a call on hold. 

 

In the Call Control area, the Emulate NOTIFY for Refer parameter is checked. This is 

required for some SIP endpoints that perform Refer based transfers across the SIP line. See 

Section 2.2 for more details. The No Refer if using Diversion parameter is checked to prevent 

IP Office from using the SIP REFER method on call forwarded scenarios that use a Diversion 

SIP header. Verizon does not support this type of refer and would respond with a “603 Decline” 

SIP message. 
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5.5. IP Office Line 

In IP Office Server Edition systems, IP Office Lines are automatically created on each server 

when a Secondary server or Expansion System is added to the solution. To edit an existing IP 

Office Line, select Line in the Navigation pane, and select the appropriate line to be configured 

in the Group pane. The screen below shows the IP Office Line to the IP500 V2 Expansion 

System. 

 

 
 

The screen below shows the IP Office Line, VoIP Settings tab. In the reference configuration, a 

fax machine is connected to one of the analog ports on the Expansion System. Fax Transport 

Support is set to T.38 Fallback. The Media Security is set to Same as System (Preferred) to 

have IP Office use the system setting for media security set in Section 5.2.55 to encrypted RTP. 

Default values were used for all other parameters. 
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5.6.  Short Codes 

In this section, various examples of IP Office short codes will be illustrated. To add a short code, 

right click on Short Code in the Navigation pane, and select New. To edit an existing short code, 

click Short Code in the Navigation pane, and the short code to be configured in the Group pane. 

 

In the screen shown below, the short code 9N is illustrated. The Code parameter is set to 9N. 

The Feature parameter is set to Dial. The Telephone Number parameter is set to N. The 

Telephone Number field is used to construct the Request URI and To Header in the outgoing 

SIP INVITE message. The Line Group ID parameter is set to 58: Vz-IPT, which directs the call 

to the ARS. See Section 5.99 for example ARS route configuration.  

 

 

5.7. Users, Extensions, and Hunt Groups 

In this section, examples of an IP Office User, Extension, and Hunt Group will be illustrated. In 

the interests of brevity, not all users and extensions shown in Figure 1 will be presented, since 

the configuration can be easily extrapolated to other users. To add a User, right click on User in 

the Navigation pane, and select New. To edit an existing User, select User in the Navigation 

pane, and select the appropriate user to be configured in the Group pane. 
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5.7.1. SIP User 

The following screen shows the User tab for user 6241. As shown in Figure 1, this user 

corresponds to the Avaya J169 SIP endpoint. 

 

 
 

Optionally, if the user does not have a 10-digit telephone number assigned to it in the incoming 

call route (Section 5.8), a User Short Code can be created to set the outbound caller ID. The 

following screen shows the Short Codes tab for user 6322. This user is not associated with an 

incoming call route. The Telephone Number is set to Ns7329450232. The number after “s” is 

used to construct the From and Contact headers in the outgoing SIP INVITE message. 
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The following screen shows the Extension information for this user. To view, select Extension 

from the Navigation pane, and the appropriate extension from the Group pane. 

 

 
 

The following screen shows the VoIP tab for the extension. The IP Address field may be left 

blank. Check the Reserve Avaya IP endpoint license box. The Codec Selection parameter may 

retain the default setting “System Default” to follow the system configuration shown in Section 

5.2.5. The Media Security parameter may also retain the default setting Same as System 

(Preferred) to follow the system configuring shown in Section 5.2.5. 
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5.7.2. Hunt Groups 

During the verification of these Application Notes, users could also receive incoming calls as 

members of a hunt group. To configure a new hunt group, right-click Group from the 

Navigation pane, and select New. To view or edit an existing hunt group, select Group from the 

Navigation pane, and the appropriate hunt group from the Group pane. 

 

The following screen shows the Group tab for hunt group 401. The telephone extensions in the 

User List are rung based the extension that has been unused for the longest period, due to the 

Ring Mode setting Longest Waiting (i.e., “longest waiting”, most idle user receives next call). 

Click the Edit button to change the User List. 
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5.8. Incoming Call Routes 

In this section, IP Office Incoming Call Routes are illustrated. To add an incoming call route, 

right click on Incoming Call Route in the Navigation pane and select New. To edit an existing 

incoming call route, select Incoming Call Route in the Navigation pane, and the appropriate 

incoming call route to be configured in the Group pane. 

 

In the screen shown below, a simple incoming call route is illustrated. The Line Group Id is 21, 

matching the Incoming Group field configured in the SIP URI of the Call Details tab for the 

SIP Line to Verizon Business, in Section 5.4.4. The Incoming Number field is set to the 

incoming number on which this route should match. Matching is right to left. 

 

Note: When the destination is a user’s extension, the Incoming Number can be used to 

construct the From and Contact headers in place of the extension number in the outgoing SIP 

INVITE message for the user, for caller ID purposes. 

 

 
 

On the Destinations tab, select the destination extension from the pull-down menu of the 

Destination field. Click the OK button (not shown). In this example, incoming calls to  

7329459241 on line 21 are routed to extension 6241.  

 

 
 

Repeat this process to route the rest of the Verizon DID numbers to additional users, as well as 

other Avaya IP Office destinations (Hunt Group, Voicemail, Short Codes, etc.). 
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5.9. ARS Routing 

While detailed coverage of ARS is beyond the scope of these Application Notes, this section  

includes some basic screen illustrations of the ARS settings used during the compliance test. 

 

As described in Section 5.6, Short Code 9N was defined for ARS access. Therefore, outbound 

calls via ARS are dialed as 9 plus the number. ARS will strip off the 9, and it will process the 

call based on the remaining digits.  

 

To add a new ARS route, right-click ARS in the Navigation pane, and select New (not shown).  

The following screen shows the ARS Route ID 58, created in the sample configuration. The 

sequence of Xs used in the Code column of the entries are used to specify the exact number of 

digits to be expected following the access code. The first entry below shows that for calls to area 

codes in the North American Numbering Plan, the user dials 9, followed by 10 digits. The list of 

codes defined below is simply an example and not intended to be prescriptive. Other dialing 

codes may be appropriate for different customer networks. The Line Group ID is set to 21 

matching the number of the Outgoing Group configured on the Call Details tab of SIP Line 21 

to Verizon Business (Section 5.4.4). 
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5.10. Save Configuration 

Navigate to File → Save Configuration in the menu bar at the top of the screen to save the 

configuration performed in the preceding sections. 

 

The following will appear, with either Merge or Reboot selected for the Change Mode, based 

on the nature of the configuration changes made since the last save. Note that clicking OK may 

cause a service disruption. Click OK if desired. 
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6. Avaya IP Office Expansion Configuration 
Navigate to File → Open Configuration (not shown), select the proper Avaya IP Office system 

from the pop-up window, and log in using the appropriate credentials. Clicking the “plus” sign 

next to IP500 Expansion on the left navigation pane will expand the menu on this server. 

 

 

6.1. Expansion System - Physical Hardware 

In the sample configuration, the IP500 V2 Expansion System contained a PHONE8 analog card 

and a COMBO6210 card, for the support of analog and digital stations. Also included is a 

VCM64 (Voice Compression Module). Both the VCM64 and the COMBO6210 cards provide 

voice compression channels to the control unit. Voice compression channels are needed to 

support VoIP calls, including IP extensions and or IP trunks. 
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6.2. Expansion System - LAN Settings 

In the sample configuration, LAN1 is used to connect the Expansion System to the enterprise 

network. To view or configure the LAN1 IP address, select System on the Navigation pane. 

Select the LAN1 → LAN Settings tab on the Details pane. As shown in Figure 1, the IP 

Address of the Expansion System is 10.5.5.180. Other parameters on this screen may be set 

according to customer requirements 

 

 
 

Defaults were used on the VoIP and Network Topology tabs (not shown). 

6.3. Expansion System - IP Route 

To create an IP route for the Expansion System, right-click on IP Route on the left Navigation 

pane. Select New (not shown). The configuration is similar to the one on the Primary server 

(Section 5.33), with the difference that in the reference configuration, the default gateway for the 

Expansion System is 10.5.5.2. 
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6.4. Expansion System - IP Office Line 

The IP Office Lines are automatically created on each server when the Expansion System is 

added to the solution. Below is the IP Office Line (Line Number 17) to the Primary server. 

 

 
 

In the reference configuration, a fax machine is connected to one of the analog ports on the 

Expansion System. To accommodate T.38 fax, select the VoIP Settings tab and set Fax 

Transport Support to T38 Fallback. The Media Security drop-down menu is set to “Same as 

System (Preferred)” to have IP Office use the system setting for media security set in Section 

5.2.5 to encrypted RTP. 
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Select the T38 Fax tab. The Use Default Values box is unchecked, and the T38 Fax Version is 

set to 0. In the Redundancy area, the Low Speed and High Speed parameters are set to 2. All 

other values are left at default. 

 

 

6.5. Expansion System - Short Codes 

Similar to the configuration of the Primary server in Section 5.66, a Short Code is created to 

access ARS. In the reference configuration, the Line Group ID is set to an ARS route illustrated 

in the next section. 
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6.6. Expansion System - Automatic Route Selection – ARS 

The following screen shows an example ARS configuration for the route named To-Primary on 

the Expansion System. The Telephone Number is set to 9N. The Line Group ID is set to 99999 

matching the number of the Outgoing Group ID configured on the IP Office Line 17 to the 

Primary server (Section 6.4). 

 

 

6.7. Save IP Office Expansion System Configuration 

Navigate to File → Save Configuration in the menu bar at the top of the screen to save the 

configuration performed in the preceding sections 

 

The following will appear, with either Merge or Reboot selected, based on the nature of the 

configuration changes made since the last save. Note that clicking OK may cause a service 

disruption. Click OK to proceed. 
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7. Verizon Business IP Trunking Services Configuration 
Information regarding the Verizon Business IP Trunking Services suite offer can be found at 

https://enterprise.verizon.com/products/business-communications/voip-and-voice-services/voip-

ip-trunking/ or by contacting a Verizon Business sales representative. 

 

The reference configuration described in these Application Notes is located in the Avaya 

Solutions and Interoperability Test Lab. Access to the Verizon Business IP Trunking Services 

suite was via a Verizon Private IP (PIP) T1 connection. Verizon Business provided all of the 

necessary service provisioning. 

 

For service provisioning, Verizon will require the customer IP address used to reach the Avaya 

IP Office. The following service access information (FQDN, ports, DID numbers) was provided 

by Verizon for the sample configuration. 

 

CPE (Avaya) Verizon Network 

adevc.avaya.globalipcom.com 

UDP port 5060 

pcelban0001.avayalincroft.globalipcom.com  

UDP Port 5071 

 

 

IP DID Numbers 

732-945-0231 

732-945-0232 

732-945-0233 

732-945-0234 

732-945-0235 

732-945-0236 

732-945-0237 

732-945-0238 

732-945-0239 

 

https://enterprise.verizon.com/products/business-communications/voip-and-voice-services/voip-ip-trunking/
https://enterprise.verizon.com/products/business-communications/voip-and-voice-services/voip-ip-trunking/
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8. Verification Steps 
This section provides example verifications of the Avaya configuration with Verizon Business 

Private IP (PIP) Trunk service. 

8.1.  Avaya IP Office 

This section provides verification steps that may be performed with the IP Office. 

8.1.1. System Status Application 

The Avaya IP Office System Status application can be used to verify the service state of the SIP 

line. From the IP Office Manager application, select File → Advanced → System Status.  

Under Control Unit IP Address select the IP address of the IP Office system under verification. 

Log in using the appropriate credentials. 
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Select the SIP line from the left pane (Line 21 in the reference configuration). On the Status tab 

in the right pane, verify that the Current State is Idle for each channel (assuming no active calls 

at present time). In the lower part of the screen, the Trace All button may be pressed to display 

real time tracing information as calls are made using this SIP Line. The Ping button can be used 

to ping the other end of the SIP trunk. 

 

 
 

Select the Alarms tab and verify that no alarms are active on the SIP line. 
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8.1.2. System Monitor 

The Avaya IP Office Monitor application can be used to monitor and troubleshoot signaling 

messaging on the SIP trunk. Launch the application from Start → Programs → IP Office → 

Monitor on the PC where IP Office Manager was installed. Click the Select Unit icon on the 

taskbar and Select the IP address of the IP Office system under verification.  
 

 
 

Clicking the Trace Options icon on the taskbar and selecting the SIP tab allows modifying the 

threshold used for capturing events, types of packets to be captured, filters, etc. Additionally, the 

color used to represent the packets in the trace can be customized by right clicking on the type of 

packet and selecting to the desired color. 
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The following example shows a portion of the System Monitor window for an outbound call 

from extension 6322, whose DID is 732-945-0232, calling out to the PSTN via the Verizon 

Business IP Trunking service. The telephone user dialed 9-1-786-331-0799. 
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9. Conclusion 
IP Office is a highly modular IP telephone system designed to meet the needs of home offices, 

standalone businesses, and networked branch and head offices for small and medium enterprises. 

 

These Application Notes demonstrated how IP Office Release 11.1 can be configured to 

interoperate successfully with a Verizon Business IP Trunking service connection to create an 

end-to-end SIP Telephony business solution. By following the example configurations provided 

in this document, customers using Avaya IP Office can connect to the PSTN via a Verizon 

Business IP Trunking service connection, thus eliminating the costs of analog or digital trunk 

connections previously required to access the PSTN. Utilizing this solution, IP Office customers 

can leverage the operational efficiencies and cost savings associated with SIP trunking while 

gaining the advanced technical features provided through the marriage of best of breed 

technologies from Avaya and Verizon. 

10. Additional References  
This section references documentation relevant to these Application Notes. In general, Avaya 

product documentation is available at http://support.avaya.com. 

 

[1] IP Office, Deploying IP Office Server Edition Solution, Release 11.1, Issue 14, April 2020 

[2] IP Office™ Platform 11.1, Deploying Avaya IP Office Servers as Virtual Machines, April 

2020 

[3] IP Office™ Platform 11.1, Deploying an IP500 V2 IP Office Essential Edition System, April 

2020. 

[4] Administering Avaya IP Office™  Platform with Manager, Release 11.1, Issue 1, April 2020. 

[5] Administering Avaya IP Office™ Platform with Web Manager, Release 11.1, Issue 1, April 

2020. 

[6] Planning for and Administering Avaya IX™ Workplace Client for Android, iOS, Mac and 

Windows, Release 3.8, Issue 1, March 2020 

[7] Using Avaya IX™ Workplace Client for Android, iOS, Mac and Windows, Release 3.8,  

Issue 1, March 2020 

[8] RFC 3261 SIP: Session Initiation Protocol. https://www.ietf.org/rfc/rfc3261.txt 

 

Additional IP Office documentation can be found at: 

https://ipofficekb.avaya.com/ 

 

 

  

http://support.avaya.com/
https://ipofficekb.avaya.com/
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           SipContentCalled
        
         
         
         
           7329450821
           7329450821
           1048833
           SipContentExplicit
           SipContentExplicit
           SipContentNone
        
         
         21
         116
         10
         10
         10
         true
         
         0
         0
         true
      
    
     false
  
   
     DISABLE
     False
     True
     False
     True
     True
     64
     1
     0
  
   SEND_LOCINFO_NEVER
   false
   false
   AllowVoicemail
   None
   false


